
Books and events everywhere this month! Here at SumProduct HQ, we are 
delighted to announce not one, but TWO new Financial Modelling books for the on-going series.  They are more violent than Game of Thrones and 
easier to pick up than sodium lauryl sulphate (look it up).  More details below.

Yours Truly is also presenting at not one, but TWO Excel events this month.  We detail the upcoming Global Excel Summit in London and Excel 
Weekend in São Paulo.  Check either or both out in person or online.

The February printing deadlines prevent us detailing copious amounts of Excel Updates this month (although there 
is one big one), but all our other regulars are back and ready to roll.  There is the usual Beat the Boredom Challenge, 
Charts & Dashboards Tips, Over to AI, Excel for Mac, Visual Basics, Power Pivot Principles, Power Query Pointers, the 
latest Power BI Updates, plus we take the P out of the A to Z of Excel functions and ALTer the Keyboard Shortcuts too.

Happy reading and remember: stay safe, stay happy, stay healthy.

Finally!

SumProduct is proud to announce two new books in the Financial Modelling series.  Just like buses, you wait and wait, and then two turn up at once!

To add to Introduction to Financial Modelling, Continuing Financial Modelling and Financial Modelling in Power BI, please welcome two new upstarts 
to the series:

	 1.	 Financial Modelling for Project Finance (Liam Bastick with Oscar Hagan):  
		  If you have a beginner's grasp in accounting, finance and Excel, you might be tempted to explore the quantitative, decision-centric world 	
		  of Project Finance, ring-fencing funding for profitable projects. 

		  This book seeks to demystify the area and show how the basic principles of financial modelling, first heralded in Introduction to Financial 	
		  Modelling, may be applied and modified here.  

		  The book explains "Project Finance" and how it differs from "project finance" at the outset. It then provides various Excel pointers on 	
		  Excel's key functions and features, before crafting together the salient points of "Best Practice" modelling. 

		  This book is practical: it provides numerous examples including a full case study showing how to model Project Finance, separating the 	
		  concepts (and modelling) of construction and operations, including delivering a Cash Flow Waterfall, Sources and Uses of Funds, various 	
		  valuation techniques, plus demonstrating how to create scenario, sensitivity and ratio analyses.

And Then There Were Five
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Global Excel Summit 2025

Excel Weekend 10

	 2.	 Financial Modelling using Dynamic Arrays (Liam Bastick): 

	 	 Through numerous examples and case studies, it details the impact of the ecosystem introduced by dynamic arrays in Excel, injecting life 	
	 	 into the jaded, stale world of financial modelling. From comparing the old methodologies to the new frontiers, this book considers how 	
	 	 dynamic arrays have reshaped Excel and made it Turing complete, with its liberal use of LET, LAMBDA, eta lambdas et al. 

		  LET invites complexity but reduces memory requirements, LAMBDA allows you to build anything, and dynamic arrays make it easy to 	
	 	 quite literally extend your ideas and your way of thinking.  See for yourself. 

	 	 Through a dynamic array of Best Practice tips, tricks, functions and features, Financial Modelling using Dynamic Arrays shows you how 	
	 	 to revamp and reinvent your financial models with Excel 365.  Recreate your development kit in this brave new world.  Erase the old and 	
	 	 embrace the arrays!

For regular and ad hoc readers, each book is a standalone tome and does not require you to read earlier vignettes.  There is a little repetition to set 
the scene, but we thought this was the better alternative than put it all in one 3,000-page book!  

Watch out for Number Six, hopefully out later this year: it won’t be a “Prisoner” for long as we introduce AI into the foray!

You can find these books both physically and electronically from all good bookshops, including Amazon.  If it’s not available at your bookshop, well…

Well, with our own Liam Bastick one of the hosts, we thought we 
should point out that the London-based Microsoft Excel conference for 
professionals and enthusiasts returns 4 to 6 February at the Soho Place 
Theatre in London.  Apparently, the Wi-Fi is even reliable!

Whilst Liam will finally achieve the lifetime ambition of performing on 
stage to a paying audience in Soho (we presume they’re paying for him to 

stay clothed – Ed.), the speaker list sounds like a who’s who in Excel, with 
fellow Excel MVP Leila Gharani headlining amongst many other notable 
bods.

The first two days are in person as well as online with Day 3 online only.

For full details, please see https://globalexcelsummit.com/.

And that’s not all.  Almost straight after the conclusion of the Global Excel Summit, the Brazilian event Excel Weekend 10 comes at you too!  

Not sure about the Excel blue (!), but it’s a landmark event for Excel 
Weekend as it reaches its 10th edition.  Congratulations!!  It once again 
welcomes Excel enthusiasts from various corners of Brazil and worldwide 
to discuss innovative techniques and the latest trends in the tool and the 
market.

The hybrid event begins with an in-person day, which takes place on 
Friday, February 7, at the Microsoft Reactor São Paulo space.  Participation 
is 100% free and the event is broadcast live on YouTube worldwide.

On February 8th and 9th, Excel Weekend 10 features online lectures 
with Microsoft MVPs (again including some of us here at SumProduct) 
from other countries, in different languages, and promotes technical 
discussions via Microsoft Teams between Excel communities from 
different regions.  Feel free to join and learn the latest news from 
renowned professionals in Microsoft technologies!

For more details, go to https://10.excelweekend.com/ 
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Beat the Boredom Challenge

With many of us currently “working from home” / quarantined, there are 
only so Zoom / Teams calls and virtual parties you can make before you 
reach your (data) limit.  Perhaps they should measure data allowance 
in blood pressure millimetres of mercury (mmHg).  To try and keep our 

readers engaged, we will continue to reproduce some of our popular Final 
Friday Fix challenges from yesteryear in this and upcoming newsletters.  
One suggested solution may be found later in this newsletter.  Here’s this 
month’s…

We’ve talked at long length about Dynamic Arrays and how the value that they add to Excel and the solutions that we can build with them.  Sometimes, 
as we keep pushing to solve ever increasingly difficult problems, we end up hitting some fairly hard limits.

In this instance, we have a list of employees where we know what division each person works in. We also have a list of capabilities that each 
employee brings to the team.  If we select an employee, we’d like to know what their whole team brings to the table.

So to do this, we naturally follow some basic steps – what’s your employee’s name, and what division are they from?  So simple, so INDEX(MATCH()):

=INDEX(Table1[Division],MATCH(Employee_Selection,Table1[Employee],0))

Yes, of course, you can use XLOOKUP but we’re deciding to use a formula that works in all versions of Excel.

Then, we might even be able to find a list of all the employees that work in that division.  That’s what FILTER is for, right?

=FILTER(Table1[Employee],Table1[Division]=Division_Selected)

Then, of course, we just need to filter our capability list on the list of employees.  Simple, right?

=FILTER(Table2[Capabilities],Table2[Employee]=Division_Employees)
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Wait, what?

This month’s challenge is very straightforward.  Can you come up with a formula to give us a list of capabilities that each person in the team can 
provide?

Sounds easy?  Try it.  One solution just might be found later in this newsletter – but no reading ahead!  

Over to AI

Here at SumProduct we write many articles for many magazines and 
our authoring contracts have been revised recently to ensure Artificial 
Intelligence hasn’t taken over our duties.  We can assure everyone they 
have not.  

But it did get us thinking: what if we did let AI loose and write a regular 
article for the newsletter?

This month, we decide to let AI loose on predicting what it will achieve 
in Excel.  Now, given we have a few Excel MVPs in the team, we want 
to be clear: there is no “insider knowledge” here.  This is AI’s prediction 
about itself!

This Month’s Prompt: What are the anticipated improvements for AI in Excel in 2025?

As we look towards the future, it's clear that artificial intelligence (AI) will continue to revolutionise the way we interact with data.  Microsoft Excel, 
one of the most widely used data analysis tools, is set to undergo significant advancements in AI capabilities by 2025.  These improvements will not 
only enhance efficiency but also empower users to make better, data-driven decisions.

In 2025, AI in Excel is expected to offer more advanced data analysis 
features.  Machine Learning (ML) algorithms will be integrated more 
deeply into Excel, allowing users to perform complex analyses with 
ease.  These algorithms will be capable of identifying patterns, trends 
and anomalies in large datasets, providing insights that were previously 
difficult to uncover.

One of the key improvements will be the ability of AI to suggest relevant 
analyses based on the data at hand.  For example, if a user inputs sales 
data, Excel's AI could automatically suggest performing a trend analysis, 
forecasting future sales or identifying key factors influencing sales 
performance.  This feature will save users time and help them focus on 
interpreting the results rather than setting up the analyses.

Data cleaning is a crucial but time-consuming task in data analysis.  By 
2025, AI in Excel will significantly streamline this process.  AI-powered 
tools will be able to automatically detect and rectify errors in datasets, 
such as missing values, duplicate entries and formatting inconsistencies.  
These tools will use advanced algorithms to ensure that the data is clean, 
accurate and ready for analysis.

Moreover, AI will be able to understand the context of the data and make 
intelligent suggestions for cleaning.  For instance, if a column contains 
dates in different formats, AI can standardise them based on the most 
common format used.  This automated approach to data cleaning will 
reduce the potential for human error and improve the overall quality of 
the data.

Natural Language Processing (NLP) is another area where AI in Excel will 
see significant advancements.  By 2025, users will be able to interact 
with Excel using natural language commands.  This means that instead 
of using complex formulas and functions, users can simply type or speak 
their queries in plain language, and Excel will understand and execute 
the commands.

For example, a user could ask, "Show me the average sales for the 
last quarter" or "Highlight the top 10% of performers in this dataset" 
and Excel's AI will process the request and provide the desired output.   
This feature will make Excel more accessible to users who are not 
familiar with advanced functions and formulas, democratising data 
analysis capabilities.

ENHANCED DATA ANALYSIS

AUTOMATED DATA CLEANING

NATURAL LANGUAGE PROCESSING
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Predictive analytics will be a cornerstone of AI improvements in Excel by 
2025.  Advanced ML models will be embedded within Excel, enabling users 
to perform predictive analyses without needing specialised knowledge 
in data science.  These models will be able to predict future outcomes 
based upon historical data, helping users make informed decisions. 

For instance, businesses can use predictive analytics to forecast sales, 
anticipate customer behaviour, and optimise inventory management.  The 
AI models in Excel will continuously learn and improve over time, ensuring 
that predictions become more accurate and reliable.  This capability will 
be particularly beneficial for small and medium-sized enterprises that may 
not have the resources to invest in dedicated data science teams.

Personalisation will be a key focus of AI advancements in Excel by 2025.  
The AI will be able to learn from users' behaviour and preferences, 
offering personalised recommendations tailored to their specific needs.  
For example, if a user frequently performs a certain type of analysis, AI 
can suggest shortcuts, templates or additional features that align with 
their workflow.

Additionally, AI will be able to provide contextual recommendations 
based upon the content of the spreadsheets.  If a user is working 
on a financial report, AI might suggest relevant financial metrics or 
visualisations that could enhance the report's clarity and impact.  This 
level of personalisation will streamline workflows and improve overall 
productivity.

Data visualisation is a critical aspect of data analysis and AI in Excel will 
make significant strides in this area by 2025.  Advanced AI algorithms 
will be able to create dynamic, interactive visualisations that adapt to 
the data being analysed.  Users will have access to a wider range of 
visualisation options, including AI-generated charts and graphs that 
highlight key insights.

Furthermore, AI will be able to recommend the most appropriate 
visualisations for the data, making it easier for users to present their 
findings effectively.  For example, if a dataset contains time-series data, 
AI might suggest a line chart or a heat map to illustrate trends over time.  
These advanced visualisations will help users communicate their insights 
more clearly and persuasively.

AI improvements in Excel by 2025 will also enhance collaboration and 
integration with other tools and platforms.  AI-powered features will 
facilitate real-time collaboration, allowing multiple users to work on 
the same spreadsheet simultaneously.  AI will be able to track changes, 
resolve conflicts and provide suggestions for improving the collaborative 
workflow.

Integration with other Microsoft products, such as Power BI and Teams, 
will be more seamless, enabling users to leverage the full ecosystem 
of tools for their data analysis needs.  AI will assist in integrating data 
from various sources, ensuring consistency and accuracy across different 
platforms.  This interconnected approach will enhance the overall 
efficiency and effectiveness of data analysis processes.

The anticipated improvements in AI in Excel by 2025 will transform the way users interact with data, making advanced data analysis more accessible 
and efficient.  Enhanced data analysis, automated data cleaning, natural language processing, predictive analytics, personalised recommendations, 
advanced visualisations and improved collaboration and integration are just some of the exciting developments on the horizon.  As AI continues to 
evolve, Excel will remain at the forefront of innovation, empowering users to unlock the full potential of their data.

What do you think?  Do you agree AI will get there this year?  It will be interesting to see precisely what happens.  Send us your comments and ideas 
for questions to contact@sumproduct.com. 

Did you ever open a document and then create a copy by going to File -> Save As…?  This is a very common task in all the office applications, including 
Excel, Word and PowerPoint.  If you use a Mac, you may have been confused after you saved a copy of a file and then went to look for it and you 
couldn’t find it where expected.  When you save a copy of a file this way, you might expect that the copy would be created in the same folder where 
the original file is located, but this is not how it works on Mac.

PREDICTIVE ANALYTICS

PERSONALISED RECOMMENDATIONS

ADVANCED VISUALISATIONS

COLLABORATION AND INTEGRATION

CONCLUSION

Excel for Mac

With Steve Kraynak joining the team, we thought we would exploit his 
knowledge and recant all about Microsoft Excel for Mac.  Each month, 
we’ll cover a different topic to help you understand how Excel for Mac 
is different than Excel for Windows.  This month, we discuss how the 

destination folder is chosen when you save a copy of a file.  This is also 
applicable to Word and PowerPoint.  Be sure to pay attention to the 
folder destination when you do ‘Save a Copy’ or ‘Save As’ on a Mac.
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Here are typical steps to make a copy of a file:

	 •	 open it, then go to File -> Save a Copy… (or Save As…)

	 •	 type a new name

	 •	 press Save.

You might expect the new file to be saved into the same folder as the 
original.  On Windows, that’s how it works.  It seems intuitive.  You 
simply saved a copy of the file with a new name, but didn’t change the 
folder destination.

However, it doesn’t work the same way on Mac.  Instead of picking the 
folder of the original file that you opened, Excel for Mac picks the folder 
where you last saved or opened any file by going through the File -> 
Open or File -> Save dialog.  If you open a few files, it will pick the folder 
of the last file that you opened, which may not be the same as the file 
you’re trying to copy.

Also, if you open a file by going to the folder in Mac’s Finder app and 
double-clicking the file, Excel won’t pick that folder as the “last used” 
folder.  It only uses the last folder where you opened or saved via the File 
menu in Excel (same for Word and PowerPoint).

Sometimes when the ‘Save a Copy’ dialog appears, it won’t have any 
folder selected.  You might see that the ‘Recent Folders’ pane appears, 
but the Save button is greyed out, because no folder has been selected, 
as shown below.  At least when this happens, you won’t be able to 
accidentally save the file into a folder you didn’t pick.

Key Takeaway

Always take note of the destination folder when you do ‘Save a Copy…’ or ‘Save As…’ on Mac.  Otherwise, you may need to go searching for your file 
later.

We’ll continue next month…

Visual Basics

We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.   
This month, we look at the interaction between charts and macros.

You may know that as part of our business, we provide model auditing 
services to clients, checking spreadsheets for errors.  As part of that 
process, we often take two versions of a file and run software over it to 
identify changes in inputs and formulae.

However, our software doesn’t work on charts – it only looks through the 

cells in a workbook.  Instead, we had to check the charts manually, which 
can take a very long time when we’re working with multiple charts.

As with many other manual processes, that prompted us to ask – why 
can’t we create a macro to do it?
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Here, we’ll look at the thought process around creating a macro that would help us to identify a chart’s details and present the results to a user.   
The Chart Identifier macro would need to report on the following characteristics of a chart:

	 •	 the sheet that the chart was located on

	 •	 the name of the chart object

	 •	 a list of the different data series that were being reported

	 •	 the formulae of each data series being reported on

	 •	 the axis formula for each item

	 •	 any x / y / z axis formulae that might apply for things like Bubble charts.

That’s quite a lot!  We need to step through this quagmire.  We effectively need to go through the following steps:

	 •	 define the target / output file, save target details

	 •	 determine the series details and loop through to extract them

	 •	 extract out the relevant name / y-axis / x-axis / Bubble size from the formula and clean up.

Firstly, we need to define what file contains the charts, and where we want to store the results.  For the macro to work properly, we don’t want to 
modify the base file (which we can’t do in a model audit), so we’re going to create a new workbook to store the results.

We can use the command:

ActiveWorkbook refers to the Excel file that is currently active (i.e. the 
one that Excel is focused on and will be performing actions to).  Presuming 
that we are running this macro when we are looking at the workbook we 
have sheets on, we can set the first variable, TargetWorkbook to be that 
file.  Then, Workbooks.Add will create a new, blank Excel file that we can 
define as our OutputWorkbook.

Defining the Excel files will allow us to use OutputWorkbook.Activate 
and TargetWorkbook.Activate to switch between our files, as we will 
need to look at the Target to find chart information, and swap back to 
the Output to store the result.

Then, all we need is to identify the details that we want to store in the 
output and set up the headings we need to get the output file ready to 
take inputs.

mailto:contact%40sumproduct.com?subject=
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

We’re then going to do one more thing: create named ranges that we can use to define where our outputs start and consider how many rows are 
included.

Thus, this first step has identified the workbooks, and has set up the output page to start taking details.  

We will continue next month…

Charts and Dashboards

It’s time to chart our progress with an introductory series into the world of creating charts and dashboards in Excel.  This month, we consider creating 
a chart label that can move.

Chart labelling is an interesting topic.  We have previously talked about the Dynamic Chart Labels and played around with the Dynamic Chart Labels 
for Stacked Column Charts.  Now, we wish to discuss more tips concerning creating a chart label that can move along with its associated data series. 

For example, imagine we have data for actual and budget sales for a given financial year.  Actual data will be filled in at the close of each month, e.g.

We want to create a line chart to illustrate the sales performance against the budget data.  We will not need the legend for the chart, as we wish to 
place the labels next to the end point of each series, which move depending upon the data we input, as illustrated below:
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First, to create a chart, select the range F12:H24 and navigate to the Insert tab on the Ribbon, and then select a line chart.  The initial line chart will 
look like the one below:

We will undertake some formatting at this point.  First, we will extract the dynamic chart title by pointing it to cell D10.  Then, we will remove the 
gridlines from the chart area and emphasise the border line for the two axes.  The chart now appears like below:

To get the series chart label for only the end point of a series, click on the series, then click once again on the data point we want to add the label 
on, right-click and choose ‘Add Data Label’.
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As the label stays too close to the chart border, we will resize the plot area.

To change the chart label to the series name instead of the data value, right-click on the data point (not the label) and select ‘Format Data Label’.   
In the ‘Format Data Label’ pane, under ‘Label Options’, tick ‘Series Name’.

The chart will now look like the one below:
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If we change the budget data, the label is moving with the chart series.

We will repeat the same process to get the label for the Actual series. 

However, when we add more data to the chart, the label is not moving and is overwritten by the series line.
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However, when we add more data to the chart, these labels are not moving and would be overwritten by their respective series lines, because we 
had been adding data labels for a single point in each series.  In summary, the data labels were not dynamic yet.

Guess what we are going to do now!

To fix this, we will need a helper series which plots only the last actual data point.  In cells I13:I24, we will add a series call ‘Actual’ – which will be 
used as the label later – and use the formula as shown below to get only the last actual data point.  We will also need to rename the existing ‘Actual’ 
series to ‘Actual Data’ to distinguish with the new series.  All other data point with #N/A errors will be hidden.  The #N/A errors are deliberate, as 
they prevent the points being plotted on a line chart.  

We have used the formula

=IF(MATCH(F13,$F$13:$F$24,0)=COUNTA($G$13:$G$24),G13,NA())

Next, let’s remove the ‘Actual’ data label, and then right-click on the chart area and choose ‘Select Data…’:
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In the ‘Select Data Source’ dialog, under ‘Legend Entries (Series)’, click Add.

Select cell I12 to be the Series name and cells I13:I24 to be the Series values and click OK.

The chart now looks like the one below.  A new ‘Actual’ series is added, with only one data point overlapped by the ‘Actual Data’ series (making it 
difficult, if not impossible, to see).  
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To format the Actual series only, right-click on the chart and select ‘Format Data Series’.  In the ‘Format Data Series’ panel, under ‘Series Options’, 
choose ‘Series “Actual”’.

The data point is highlighted, right-click on it and choose ‘Add Data Label’.

Again, right-click on the label, select ‘Format Data Label’ and tick ‘Series Name’.
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We won’t need the legend, hence, click on it and hit Delete.  We may also need to resize the plot area.  The chart now looks like this:

Now, if we add more actual data, the chart title changes and the label moves along with the series!

More next time.

Power Pivot Principles

We continue our series on the Excel COM add-in, Power Pivot.  This month, we continue considering EARLIER…

Last month’s newsletter explained how the EARLIER function worked and we showed how to use the EARLIER function to create a calculated column 
that ranks products based on total sale amounts.  This month, we’re going to cover another application for the EARLIER function: how to create a 
cumulative total column in Power Pivot. 

In this example, we will be using the following dataset (this image is not exhaustive): 
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After loading the data to our data model, we may use the EARLIER function to create a cumulative total column.  For example, say we wish to write 
a DAX formula that can calculate the cumulative amount sold for each product, ascending with the price.  The formula would look like this: 

=CALCULATE(
	 SUM([Amount Sold]),
	 FILTER('SaleTbl',
	 SaleTbl[Price] <= EARLIER(SaleTbl[Price])
	 )
)
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This formula uses the same logic that we covered previously regarding the inner and outer row context.  To avoid repeating ourselves, we will only 
go over it briefly here:

	 1.	  The FILTER function is evaluating the Price for each row for the entire table, inner row context
	 2.	 The function then has to evaluate ‘EARLIER(SaleTbl[Price])’.  The EARLIER function instructs the function to evaluate the outer row 	
		  context which is just ‘SaleTbl[Price]’.  On the first row, this evaluates to ‘$0.00’, which is the price of the first row

	 3.	 The FILTER function then returns with a table with all of the rows that have a price that is greater than or equal to ‘$0.00’
	 4.	 The CALCULATE function then sums the Amount Sold for all of these rows which is incidentally 43 (in the first row)
	 5.	 Steps 1 to 4 are repeated for the rest of the rows in the table. 

If you are still confused as to how this works, we’d recommend reading last month’s article over how the EARLIER function works in greater detail.  
Let’s see if the EARLIER function works with dates too. 

We will be using the following dataset: 

We can use the following DAX code to create a calculated column: 

=CALCULATE(
	 SUM(SaleDataDates[Total Sales]),
	 FILTER('SaleDataDates',
	 SaleDataDates[Date] <= EARLIER(SaleDataDates[Date])
	 )
)
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The EARLIER function works with dates too!

That’s it for this month; more next time.  

Last time, we looked at the ‘Merge Column’ functionality and the current 
differences between the way it works on the ‘Transform’ and ‘Add Column’ 
tabs.  This time, we will look at the ‘Standard’ option available on these 
tabs for numeric columns.  In this case, there are reasons why the standard 

option behaves differently for each tab.

Let’s start with some simple data, where we will focus on the price.  In the 
‘Transform’ tab, we may modify our price column using ‘Standard’ options:

We can choose to apply a ‘Standard’ reduction by multiplying my prices by 0.9, viz.

Power Query Pointers	

Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from  
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we look at 
the differences in the way that the ‘Standard’ button works on the ‘Transform’ and ‘Add Column’ tabs.
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This will change the existing column.

However, imagine we have decided we wish to keep our existing column and see discounted prices in a new column.  In this case, we should use the 
‘Add Column’ tab instead:

The process looks the same as for the ‘Transform’ tab, until we come to 
enter the value used for multiplication.  We then see we have the option 
to use values from a column as an alternative to using a fixed value.  This 

was not available in the ‘Transform’ tab.  We will use a fixed value for 
now and complete our action.  We would have liked the option to name 
our new column, but we can change this later.
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A new column Multiplication has appeared.  If we rename this to ‘Sale Price’, we can see both of our prices:

Since we were given the option to select values from a column as part of the ‘Standard’ multiplication functionality, let’s try selecting two numeric 
columns to see what options are available on ‘Standard’.

Having selected Price and Quantity, we have the option of creating a new column by combining the values in the selected columns.  We can perform 
all the ‘Standard’ operations with the exception of ‘Percentage’:
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Let’s opt to multiply our columns and create a new column which we will rename to show the potential returns if we sell all our stock at pre-sales 
prices.  We may create another column from the Sale Price and Quantity to show the effects of the proposed sale.

Whereas the ‘Standard’ option from the ‘Transform’ column enables us to perform simple operations on a numeric column, the ‘Standard’ option 
from the ‘Add Column’ tab may be used to combine data from more than one column and present our results whilst still showing the original data.  
Some ‘Standard’ options are even available for more than two [2] columns.

This can be a quick way to create a new column via addition or multiplication without creating a custom column.

Until next month.

Power BI Updates

After last month’s hiatus, the Power BI updates return this month.  There is a new ‘Explore this data’ option in the visual options menu, plus the 
Treemap visual now boasts three [3] Tiling methods for enhanced visualisation.  Other highlights include the Preview of the Tabular Model Definition 
Language (TMDL) scripting experience and the ability to track your semantic model version history.
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The full list of updates is as follows:

Copilot and AI
	 •	 Unlock suggested questions from standard prompts in Copilot

Reporting
	 •	 Explore this data: new entry point from a visual
	 •	 Storytelling in PowerPoint: new Reset behaviour
	 •	 Storytelling in PowerPoint: supporting Page Up and Page 	 	
	 	 Down 
	 •	 Save to OneDrive and SharePoint: updated file picker 	 	
	 	 (Preview)
	 •	 Enhancement to Text slicer (Preview) 
	 •	 Enhancements to Treemap visual     

Modelling
	 •	 Semantic model version history (Preview)
	 •	 Edit your data model in the Power BI Service: updates 	 	
	 	 (Preview) 
	 •	 Live edit of semantic models in Direct Lake mode with Power 	
	 	 BI Desktop: updates (Preview) 
	 •	 TMDL scripting experience (Preview)  

Data Connectivity

	 •	 New Snowflake connector implementation (Preview)

Visualisations
	 •	 Drill Down Scatter PRO by ZoomCharts: the All-in-One Scatter 	
	 	 visual
	 •	 Lollipop Chart by Powerviz
	 •	 Inforiver Super Filter
	 •	 Inforiver Analytics+ 4.2

Other

	 •	 Now in Power BI Desktop: OneLake catalogue.

Let’s look at each in turn.

Unlock suggested questions from standard prompts in Copilot

Whilst in Preview mode, when selecting from standard prompts after launching Copilot or using the prompt guide, a new prompt ‘Answer a question 
about the data’ has now become available.  Selecting this prompt will unlock three [3] suggested questions to help you explore your data.

You can continue to click the prompt by scrolling up or from the prompt 
guide (book icon) to generate three more suggested questions if none 
of the first set are interesting to you.  Furthermore, authors may also 

personalise these suggested questions using Q&A setup in Desktop for 
a particular semantic model.  With this feature, suggested questions will 
now show up in both Copilot and the Q&A visual.

Exploring your data has become simpler with the recently added 
‘Explore this data’ option to the visual options menu.  This lightweight 
and focused experience allows users to launch Explore and easily tweak 
their visual (change chart type, add new data, filter and more) and see 

the underlying data, making it easy to get the answers they need without 
all the distractions and extra complexity of reports.  

You simply select ‘Explore this data’ in the ‘More options’ menu and start 
exploring the visual.

Explore this data: new entry point from a visual
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Storytelling in PowerPoint: new Reset behaviour

Storytelling in PowerPoint: supporting Page Up and Page Down 

You can now use the Page Down / Up keys on your keyboard to quickly navigate between slides when using the Power BI add-in.  This is especially 
useful when the add-in captures the entire slide, and you want to advance the slide rather than trigger a Power BI event.

When integrating a report into your presentation, it is important to 
ensure that it remains stable and unaltered.  This add-in refreshes data 
from Power BI without modifying the report definition.

However, since Power BI reports are dynamic, sometimes you may 
want PowerPoint to get the latest changes done in the report in Power 

BI Service.  Previously, you had to remove and re-embed the report 
to achieve this.  Now, with the improved ‘Reset’ command, you can 
choose either to reset the add-in to its original state as initially added 
to the presentation or to reset and update it with the current view from  
Power BI.
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Save to OneDrive and SharePoint: updated file picker (Preview)

Enhancement to Text slicer (Preview)

Updates have been made to the Power BI file picker to simplify navigation and file-saving processes.  Microsoft has considered the feedback received 
regarding the current file picker and has decided to make significant improvements in response.  In this update, the Power BI file picker now aligns 
more closely with the Office experiences you are familiar with.

New updates include:

	 •	 improved experience when opening and saving files in One Drive and SharePoint

	 •	 easy access to reports in OneDrive and SharePoint

	 •	 navigating between folders in various workspaces

	 •	 adding new folders to existing workspaces

	 •	 pinning folders and files in the file picker.

It is noted that these updates may disrupt your workflow.  Therefore, they are not enabled by default.  To access the updates, open the Desktop 
application, go to ‘Options and settings’ (under the File Menu) -> Options -> Preview features, select the checkbox to enable ‘Show the new file 
saving and open experience’ then select ‘OK’ to accept the setting.

Soon, these settings will be on by default and will no longer require an opt-in.

Adding filtering with multiple values brings more 
control to data slicing.  Future enhancements 
are still planned as Power BI is modified to 
improve its visualisation capabilities with the 
Text slicer.  

Following the November 2024 Text slicer release, this update enhances 
functionality and user experience by allowing multiple text selections.  
This Text slicer is currently in Preview.  To enable the Text slicer, go to 
Options and settings -> Options -> Preview features -> Text slicer visual 
to make sure it is selected, and then simply restart Power BI.

This month’s enhancement adds a new Slicer settings control with 
an on / off toggle allowing the slicer to ‘Accept multiple values’.  All 
other existing formatting options for the Input text, ‘Apply’ button and  
‘Input’ text box from the November update remain the same in the 
Format pane.

After creating a Text slicer visual and adding a text field from the data 
model, users may filter the dataset based on user input.  Simply click the 
slicer input box, type your text and apply the filter either by clicking the 
apply icon, pressing ENTER or else clicking outside the visual.  The slicer 
immediately filters and displays the results, and you can repeat these 
steps to add more text selections.

When the ‘Accept multiple values option’ is enabled, additional text 
may be added to the slicer by repeating these steps, thereby allowing 
multiple selections for filtering the dataset.  Keep in mind that switching 
the toggle on or off will clear any previous text selections.
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Enhancements to Treemap visual

This month’s update includes significant enhancements to the Treemap 
visual, with three [3] new Tiling methods that improve layout options, 
plus new spacing controls to enhance the visual’s appearance and 
usability.  These features are aimed at offering better control and 
customisation, resulting in more precise Treemaps in Power BI.

Treemap visuals are powerful tools for data visualisation that allow users 
to represent hierarchical data through nested rectangles.  Each branch 

of the hierarchy is represented by a rectangle, which is then tiled with 
smaller rectangles representing sub-branches.  This structure allows for 
quick comparison of different category proportions.

To generate two-level Treemap visuals, ensure that both the Category 
and Details fields are enabled.  This allows you to visualise the hierarchical 
relationships between various categories and their subcategories in a 
clear and organised manner.

There are three [3] new Tiling methods:

	 1. 	 Squarified: this method uses a squarified Treemap algorithm to prevent elongated rectangles, creating a balanced layout.   
		  It arranges rectangles so their aspect ratios are close to squares, making size comparisons potentially easier

	 2.	 Binary: this method continuously divides the chart area into two [2] sections whilst incrementally adding new rectangles / nodes creating 	
		  a balanced and visually appealing Treemap.  Each hierarchy level further splits the space, resulting in an organised Treemap that adapts to 	
		  the dataset’s structure.  It may produce different visual characteristics compared to squarified algorithm depending on the dataset

	 3.	 Alternating (Columns, Rows): the alternating method clearly distinguishes categories by first splitting them by columns and then within 	
		  each column by rows.  This method effectively organises datasets with numerous hierarchical levels.
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This month’s update also introduces new spacing options to enhance the readability and appearance of the Treemap visual:

	 •	 Space between all nodes: this setting introduces gaps between adjacent nodes at all hierarchy levels, reducing clutter and improving 	
		  clarity

	 •	 Space between groups: by adding extra space around each node group, this option visually separates different hierarchical groups, which 	
		  helps to visually distinguish categories within the hierarchy.

Semantic model version history (Preview)

This update also announces the public Preview of semantic model version history.  This feature aims to empower self-service users by providing 
confidence to recover from critical mistakes when editing semantic models on the web.  In this Preview, versions will be automatically captured in 
an Office-like history pane for your web-edited Premium semantic models.  You can easily select and restore any of these previous versions of your 
semantic model.
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Additionally, you have the option to manually save versions to the version history for your semantic model.

Edit your data model in the Power BI Service: updates (Preview) 

The following improvements to the data model editing in Power BI Service Preview have been introduced in this update.

ON BY DEFAULT PREVIEW FOR PREMIUM WORKSPACES

With the release of semantic model version history, Microsoft will start enabling the workspace-level Preview feature for editing data models in 
Power BI Service.  Users may edit the data models workspace setting, which will be turned on by default for Premium workspaces.  If you prefer, you 
can still disable the workspace Preview for your workspace.  Power BI administrators will still have the ability to enable or disable data model editing 
in Power BI Service for the entire organisation or specific security groups through the admin portal.

VIEWING MODE

Now, when you open your semantic models on the web, it will default to Viewing mode.  This allows you to easily view the model in a safe environment, 
preventing any accidental edits.  When you’re ready to make changes, simply toggle to Editing mode to make your modifications directly on the web.
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Live edit of semantic models in Direct Lake mode with Power BI Desktop: updates (Preview) 

Live editing semantic models in Direct Lake mode with Power BI Desktop is now enabled by default, allowing you to use this feature immediately 
without needing to turn on the Preview feature.  If you prefer, you can still disable this feature by turning off the live edit of Power BI semantic models 
in Direct Lake mode Preview in Options and Settings -> Options -> Preview features.

TMDL scripting experience (Preview)  

TMDL view is a new view in Power BI Desktop that lets you script, modify and apply changes to the semantic model being edited in Desktop with a 
modern code editor using Tabular Model Definition Language (TMDL – hence the name!), improving development efficiency and providing complete 
visibility over the semantic model metadata.  TMDL view offers an alternative experience to semantic modelling using code instead of a graphical 
user interface like Model view.

Benefits include:

	 •	 enhance development efficiency with a rich code editor that includes search-and-replace, keyboard shortcuts, multi-line edits and more

	 •	 increase reusability by easily script, share and reuse TMDL scripts among semantic model developers.  For example, use a centralised 	
		  SharePoint site to easily share reusable semantic model objects such as calendar tables or time intelligence calculation groups

	 •	 get more control and transparency, showing all semantic model objects and properties, and allowing changes to items not available in 	
		  Desktop GUI, such as IsAvailableInMDX or DetailRowsDefinition.

You may script any semantic model object such as a table, measure, column or perspective by selecting the objects from Data pane and dragging 
them into the code editor:

TMDL view will script the selected objects as a TMDL script and just like TMDL in VS Code you get an enriched code experience with features such as 
semantic highlighting, error diagnostics and AutoComplete.
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You may change any valid property or object within the semantic model.  For instance, the example below demonstrates how to modify the 
displayFolder property and detail rows definition of multiple measures:

When ready, you can hit the ‘Apply’ button to execute the TMDL script against the semantic model to get your changes applied.

When successful, an instant notification will be displayed, and your modelling change will be applied to the semantic model.
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In the event of a failure, your modelling changes will not be applied to the semantic model, and you can view more information about the error by 
clicking on show details, which expands the Output pane with the error details.

To get started with this feature, go to File -> Options and settings -> Options -> Preview features and check the box next to ‘TMDL View’.

The integration with Snowflake continues.  This month, Microsoft has 
introduced a new implementation for Snowflake connector, currently 
available in Preview.  To access this feature, in Power BI Desktop, navigate 
to Options and settings (under the File Menu) -> Options -> Preview 
features, click the checkbox to enable the ‘Use new Snowflake connector 
implementation’ option.  Once the option is on, all the newly created 

connections will automatically use the new connector implementation.

Your existing connections will remain unchanged.  You can also test the 
new feature by editing the queries. 

If you’re using On-prem Data Gateway to refresh your semantic model, 
make sure you have the latest version to use this feature.

The latest ZoomCharts visual, Drill Down Scatter PRO, is now available on 
AppSource.  It is designed for fully interactive Power BI reports that deliver 
quick insights and help you make decisions graphically.

Scatter PRO makes data exploration straightforward with user interactions 
like panning, zoom-in and rectangular or lasso selection.  You can also 
create a multi-level hierarchy, which will allow users to drill down by 
simply clicking on a data point marker. 

Main features:

	 •	 Drill Down: create a multi-level category hierarchy and drill 	
		  down with just a click

	 •	 Customisation: configure marker colours, shapes, outlines, 		
		  labels, threshold lines / areas, x and y axes, and more

	 •	 Data-Driven Formatting: apply marker colours, shapes, and 	
		  even images directly from data

	 •	 Area Shading: highlight areas that need attention with up to 	
		  eight [8] shapes at custom coordinates

	 •	 Dynamic Regression Line: show a linear or polynomial 		
		  regression line.  It will automatically recalculate upon any 		
		  changes in the chart.

New Snowflake connector implementation (Preview)

Drill Down Scatter PRO by ZoomCharts: the All-in-One Scatter visual
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Lollipop Chart by Powerviz

The Powerviz Lollipop chart is a variation of a Bar chart that uses lines and dots to represent data points.  It is useful for highlighting specific trends 
to help stakeholders make informed decisions.

Key features:

	 •	 Chart Options: switch easily between vertical / horizontal chart
	 •	 Marker Style: choose from Shapes, Charts, Icons, Images or Upload custom image(s)

	 •	 Small Multiples: split your visual into multiple smaller visuals

	 •	 Error Bars: add error bars to show data variability, improving analysis accuracy

	 •	 Race Chart: enhance the chart by adding animations to show data changes over time

	 •	 Cut / Clip Axis: trim / adjust the axis to accommodate the outliers

	 •	 Dynamic Deviation: analyse the deviation between two [2] bars at a glance
	 •	 Preview Slider: explore various sections of a chart in large datasets using a slider
	 •	 Conditional Formatting: find outliers by using rules for measures or categories based upon rules

	 •	 Other features included are Templates, Import / Export themes, Data Colours, Ranking and more.

Business Use Cases include sales analyses, financial reporting and market research.
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Inforiver Super Filter

Lumel’s Inforiver Super Filter has been introduced in this latest update, powered by Lumel’s patented Time-Period Selector and alert Induced 
Selections.  This visual is free with community support.  They claim it is a single visual for all your filter / slicer needs, including date periods, 
categories, hierarchies, search, alerting, bulk copy / paste, and more.

Features include:

	 •	 Facet Filtering: group multiple slicers into one with a cascading effect

	 •	 Date Filtering:
			   ○	 Slider / Calendar Date-picker / Relative Date options

			   ○	 Different Calendar Viewing modes:

	 	 	 	 	 ▪	 Multi-Year: select months across multiple years for year-on-year / seasonal analysis

	 	 	 	 	 ▪	 Year: select months / quarters for month-over-month / quarterly analysis

	 	 	 	 	 ▪	 Month: select specific dates for detailed analysis
	 	 	 	 	 ▪	 Date Range Selection in month mode for custom timeframes

	 	 	 	 	 ▪	 Week Mode: track weekly trends and milestones within specific months

	 	 	 	 	 ▪	 Day Mode: granular filtering for time-sensitive analysis

			   ○	 Auto-updating Dynamic Date Presets like Year To Date / Last Month for date range

			   ○	 Fiscal Year Support: configure with no code
			   ○	 Calendar Heatmap: track trends over time

	 •	 Bulk Filtering: copy-paste values from Excel for mass filtering

	 •	 Save Filters: quickly apply frequent selections
	 •	 Advanced Search: pattern-based search, alphanumeric, focused text filtering

	 •	 Analytical Features: rank performers, apply conditional formatting, and add subtitles for context

	 •	 Flexible Layouts: vertical, horizontal, list, dropdown, tile, and more options.
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Inforiver Analytics+ 4.2

Inforiver Analytics+ (100+ Charts + Cards + Tables) by Lumel is rearchitected and redesigned so that enterprise customers may migrate their legacy BI 
platform reports and dashboards from Tableau, Spotfire, Qlik, Cognos, OBIEE, SAC, or their static PowerPoint dashboards from Think-cell or Mekko 
Graphics and consolidate them with Microsoft Power BI.
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Benefits include:

	 •	 single visual with 100+ chart types, including numerous advanced and special chart types missing in Power BI

	 •	 support for use cases where you need a large number of data points 

	 •	 annotations and data point storytelling like Think-cell

	 •	 visual calculated formulae for rows and columns with quick editing

	 •	 multi-dimensional visualisation (hierarchy support for all three [3] axes) for visual pivot table-like exploratory experience

	 •	 multi-measure visualisations (integrated variances)

	 •	 small multiple / Trellis for all chart types, KPI cards, and elegant Excel-like tables for Tableau and Spotfire

	 •	 split and group measures into Trellis panels like Tableau

	 •	 no code and ease of use with on-canvas formatting

	 •	 reading view interactivity like in Tableau or Qlik-sense

	 •	 flexible KPI cards with Sparkline charts and presets

	 •	 storyboarding: rapidly build dashboards in minutes with templates and smart layouts.

Now in Power BI Desktop: OneLake catalogue

The OneLake catalogue (catalog for our US readers) is now part of the Power BI Desktop experience, providing a consistent and seamless way to 
discover and explore data.  This update ensures alignment with the broader Fabric ecosystem, offering users a unified and familiar experience across 
tools.

More next month.

Power Query Pointers	
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However, the one piece of news to report here is BIG news.  Since 
the software giant launched Microsoft 365 (formerly Office 365) to 
consumers in 2013, Microsoft has steadily delivered new applications 
(apps), features and benefits to subscribers.  These include advanced 
security with Microsoft Defender, creative tools like Microsoft Clipchamp, 
and various enhancements to Word, Excel, PowerPoint, OneNote and 
Outlook.

Now, Microsoft has announced that they are bringing Microsoft Copilot 
and Microsoft Designer to Microsoft 365 Personal and Family subscribers 
in most markets worldwide.  Their availability will vary by device / 
language, with features varying by platform.  Minimum age limits may 
apply to use some of the AI features, which will only be available to the 
subscription owner and cannot be shared.  Indeed, Copilot features in 
Outlook apply to accounts with @outlook.com, @hotmail.com, @live.
com, or @msn.com email addresses and are available in Outlook.com, 
Outlook built into Windows, Outlook on Mac, and iOS and Android apps, 
but usage limits will apply.

Nonetheless, these changes bring the transformative power of AI to the 
personal productivity tools that millions of people use every day. 

Most readers here will be familiar with Copilot and what it brings to the 
melting pot, but Microsoft Designer is announced in this mix too.  This 
provides subscribers with the opportunity to undertake more image 
creation and editing than free users may.  In addition to accessing 
Designer within apps like Word and PowerPoint, you can also use the 

standalone Designer app on the web and mobile.  You may use Designer 
to create eye-catching images by simply describing what you’re looking 
for or choosing from pre-populated ideas. 

Microsoft 365 Personal and Family subscribers will receive a monthly 
allotment of AI credits to use Copilot in Word, Excel, PowerPoint, Outlook 
and OneNote.  The credits can also be used for AI image generation and 
editing in Designer and in other AI-powered apps like Paint, Photos and 
Notepad on a device running Windows.  The monthly allotment should 
be enough for most subscribers.  For Microsoft 365 Family subscribers, 
Copilot will be available to the subscription owner and cannot be shared 
with others.  Those who frequently use Copilot can upgrade to Copilot 
Pro, without worrying about usage limits. 

For those who are concerned, Microsoft is committed to giving their 
customers control over their experience and know there are times when 
AI assistance isn’t desired (like in some academic scenarios), so they 
have added settings in apps like Word, Excel and PowerPoint that allow 
you to disable or enable Copilot as needed.

There is a cost though: Microsoft 365 Personal and Family will increase 
in the US for the first time since its release by US$3 USD (visit your local 
store to see regional pricing), although it should be noted that existing 
subscribers won’t experience the price increase until their next renewal.

Copilot for all!  

Until next month.

It’s a quiet month for Excel – relatively.

The A to Z of Excel Functions: PDURATION

Well, maybe that’s not what the PDURATION function measures…  In fact, this function actually returns the number of periods required by an 
investment to reach a specified value.  Its syntax is straightforward:

=PDURATION(rate, pv, fv)

where:

	 •	 rate is the interest rate per period
	 •	 pv is the present value of the investment

	 •	 fv is the desired future value of the investment.

All three arguments are required.
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PDURATION uses the following equation: 

It should be noted that:

	 •	 PDURATION requires that all arguments are positive values; this breaches the sign convention of other financial functions

	 •	 if argument values are not valid, PDURATION returns the #NUM! error value
	 •	 if arguments are not using valid data types, PDURATION returns the #VALUE! error value
	 •	 it does not cater for regular payments.

Please see our example below:

Imagine you are attempting to understand the relationship between two variables, which are assumed to exhibit a linear relationship:

The A to Z of Excel Functions: PEARSON
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The closer the data points are to the line of best fit on a Scatter graph, 
the stronger the correlation.  This fit may be measured numerically by a 
correlation coefficient.  There are several coefficients that may be used, 
but the one we shall consider here is the Pearson's Product Moment 
Correlation Coefficient (bizarrely denoted r), which measures the 
strength of the linear correlation between two variables.

Pearson's product moment correlation coefficient (sometimes known 
as PPMCC or PCC) is a measure of the linear relationship between two 
variables that have been measured on interval or ratio scales.  It can 
only be used to measure the relationship between two variables which 
are both normally distributed.  It is usually denoted by r, and it can only 
take values between -1 and +1.  Its value may be interpreted as follows:

To calculate Pearson's Product Moment Correlation Coefficient, r:

	 •	 Plot the scatter diagram for your data; you have to do this first to detect any outliers.  If you do not exclude these outliers in your 	
		  calculation, the correlation coefficient will be misleading

	 •	 By being able to see the distribution of your data, you will get a good idea of the strength of correlation of your data before you calculate 	
		  the correlation coefficient

	 •	 Next, check that your data meets all the calculation criteria.  The variables need to be:

			   ○	 measured on an interval / ratio scale (like weight in kilograms or distance in kilometres)

			   ○	 Normally distributed: you can check this by looking at a boxplot of your data.  If the boxplot is approximately symmetric, it is 	
				    likely that the data will be Normally distributed

			   ○	 linearly correlated: look at a significance test of the null and alternative hypotheses.

	 •	 Finally, calculate the correlation coefficient using the following formula: 

where  and  are the ith pair of array points and  and  are the means of the two arrays.

Alternatively, you can calculate this metric using the PEARSON function in Excel.  It returns the Pearson product moment correlation coefficient, r, a 
dimensionless index that ranges from -1.0 to 1.0 inclusive and reflects the extent of a linear relationship between two data sets, as explained above.

r value Interpretation

r = 1 Perfect positive linear correlation

0.8 ≤ r < 1 Strong positive linear correlation

0.4 ≤ r < 0.8 Moderate positive linear correlation

0 < r < 0.4 Weak positive linear correlation

r = 0 No correlation

-0.4 ≤ r < 0 Weak negative linear correlation

0.8 ≤ r < -0.4 Moderate negative linear correlation

-1 < r < 0.8 Strong negative linear correlation

r = -1 Perfect negative linear correlation
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The PEARSON function has the following syntax:

=PEARSON(array1, array2)

It contains two [2] arguments:

	 •	 array1 which is required and represents a set of independent values
	 •	 array2 which is also required and represents a set of dependent values.

It should be noted that: 

	 •	 the arguments must be either numbers or names, array constants or references that contain numbers

	 •	 if an array or reference argument contains text, logical values or empty cells, those values are ignored; however, cells with the value zero 	
		  [0] are included

	 •	 if array1 and array2 are empty or have a different number of data points, PEARSON returns the #N/A error value.

Please see our final example for this month below: 

More Excel Functions next month.

Earlier in this newsletter, we set a fairly straightforward challenge.  Can you come up with a formula to give us a list of capabilities that each person 
in a team can provide?

In this instance, we have a list of employees where we know what division each person works in.   We also have a list of capabilities that each 
employee brings to the team.  If we select an employee, we’d like to know what their whole team brings to the table.

Beat the Boredom Suggested Solution
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So to do this, we naturally follow some basic steps: what’s your employee’s name and what division are they from?

=INDEX(Table1[Division],MATCH(Employee_Selection,Table1[Employee],0))

Then, we might even be able to find a list of all the employees that work in that division.  

=FILTER(Table1[Employee],Table1[Division]=Division_Selected)

Then, of course, we just need to filter our capability list on the list of employees. 

=FILTER(Table2[Capabilities],Table2[Employee]=Division_Employees)

Suggested Solution

This problem suffers from a problem that has plagued arrays, not just in Excel.  The system is simply not equipped to let us calculate “an array of 
arrays”, i.e. we can’t feed in a variable number of employees into our capability filter and expect it to know how to combine the results.

The trick to working around this problem is to define the filter relationship more directly.  Instead of creating a criterion to see if the Employee 
column matches the Division_Employees, we can instead try to create a series of {1,0} results that correspond to that check.

MATCH(Table2[Employee],Division_Employees,0)

This will give us positive numbers (reflecting the employee’s position in our selected list) or #N/A if it can’t find the employee in the list.  Recognising 
this, we need to wrap it in an error check:

IFNA(MATCH(Table2[Employee],Division_Employees,0),0)

This will yield only positive numbers and zeroes in our list.

mailto:contact%40sumproduct.com?subject=
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Because positive numbers can be used as substitute for TRUE when a formula is expecting a Boolean TRUE / FALSE input, this is all we need to fill in 
our FILTER result.

=FILTER(Table2[Capabilities],IFNA(MATCH(Table2[Employee],Division_Employees,0),0))

There we go! By switching the filter direction of the “array of arrays”, we can get an array result that lines up with our filter table, allowing us to get 
the result that we’re looking for.

Did you have a better solution?  Let us know, we’d be glad to hear if there are better ways to work around this problem!
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

contact@sumproduct.com
www.sumproduct.com
+61 3 9020 2071

Sydney Address:	 SumProduct Pty Ltd,  Suite 803, Level 8, 276 Pitt Street, Sydney NSW 2000
New York Address:	 SumProduct Pty Ltd, 48 Wall Street, New York, NY, USA 10005
London Address:	 SumProduct Pty Ltd, Office 7, 3537 Ludgate Hill, London, EC4M 7JN, UK
Melbourne Address:	SumProduct Pty Ltd, Ground Floor, 470 St Kilda Road, Melbourne, VIC 3004
Registered Address:	SumProduct Pty Ltd, Level 14, 440 Collins Street, Melbourne, VIC 3000

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This time, we thought we would 
regain ALTer the alphabet, but be warned – it’s a bit of a blast from the past:

Keystroke What it does

ALT + D Activate Data menu (Excel 2003 and earlier)

ALT + E Activate Edit menu (Excel 2003 and earlier)

ALT + F Excel 2007: Activate Office button; Excel 2003: Activate File menu

ALT + H Activate Help menu (Excel 2003 and earlier)

ALT + I Activate Insert menu (Excel 2003 and earlier)

ALT + K Check Names (only when emailing, not as attachment)

ALT + O Activate Format menu (Excel 2003 and earlier)

ALT + Q Tell Me

ALT + S Send Now (only when emailing, not as attachment)

ALT + T Activate Tools menu (Excel 2003 and earlier)

ALT + V Activate View menu (Excel 2003 and earlier)

ALT + W Activate Windows menu (Excel 2003 and earlier)

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at http://www.sumproduct.com/
thought/keyboard-shortcuts.  Also, check out our new daily Excel Tip of the Day feature on the www.sumproduct.com homepage.

 

Location Course Course Date Local TIme UTC Duration

London UK Financial Modelling 17 February 2025  
- 18 February 2025 09:00 - 17:00 BST 17 February 2025 09:00 UTC  

- 18 February 2025 16:00 UTC 2 Days

Melbourne Australia Power Pivot, Power Query and Power BI 18 February 2025  
- 19 February 2025 09:00 - 17:00 AEDT 17 February 2025 22:00 UTC  

 - 19 February 2025 06:00 UTC 2 Days

Melbourne Australia ChatGPT 19 February 2025  
- 20 February 2025 09:00 - 17:00 AEDT 18 February 2025 22:00 UTC  

- 20 February 2025 06:00 UTC 2 Days

Upcoming SumProduct Training Courses
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